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1
Introduction
When you set up your ACR/Summary jobs, they often reflect routine,
scheduled processing: daily jobs, weekly jobs, monthly jobs, etc. These
jobs require historical values from prior jobs to use in balancing rules.
In the real world, however, jobs do not always reliably run daily,
weekly or monthly. We have holidays, system failures, and schedule
changes.
What do you do when the schedule is unpredictable? What if a daily
job did not run yesterday but you still need a history item for
balancing?
For these situations, ACR/Summary provides variable cycle
processing.
This guide introduces you to variable cycle processing and provides a
tutorial with step-by-step instructions. Before starting with variable
cycle processing, however, this guide reviews cycle IDs and relative
cycle processing. Reviewing these concepts will help you understand
the remainder of this guide.

Review of Cycle IDs
Before learning about relative or variable cycle processing, let’s review
what cycle IDs are about.
A cycle ID is a way to uniquely identify each run of a job. It consists of
an 8-digit cycle number and a 3-digit run number.
(Cycle number + run number) = Cycle ID

Cycle IDs are especially important for identifying and retrieving values
from history records (containing results of previous job runs) in the
history database.
Often the best choice for a cycle number is the system date associated
with the job run in Gregorian or Julian date format or a date
extracted directly from the input source. However, cycle numbers do
not have to be dates.
The examples in this guide use dates because they are easy to
understand.
Cycle IDs can be assigned various ways. In the examples in this guide,
you will assign them as an online option.
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What Is Relative Cycle Processing?
Relative cycle processing allows your ACR/Summary job to retrieve
history items based on a comparison of the current cycle to previous
cycles.
The current cycle is always classified as +000, the previous cycle is
-001, the one previous to that is -002, and so forth. You can retrieve
up to the -998 cycle.
So, to retrieve a history item from a run four cycles in the past, you
would choose a relative cycle of -004. For a job running on Friday, the
relative cycle for Thursday would be -001 and for Wednesday it would
be -002, as shown below.

The cycle accumulation option allows you to automatically total
all history items retrieved.
If you specify cycle accumulation, then the relative cycle number
refers to the oldest cycle retrieved. If you do not specify cycle
accumulation, then only oldest cycle is retrieved.

Of course, there may be processing situations where the current cycle
(+000) is not available and yet you’ve specified it in your job.
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For this situation, you can choose to do one of the following:

 Use the most recent cycle record as the +000 relative cycle.
Subsequent relative cycles are then based from this history.
This option is specified by entering Y in the Should most recent
cycle be retrieved when cycle does not match current cycle?
field.

 Do not adjust the cycle numbers.
This option is specified by entering N in the Should most recent
cycle be retrieved when cycle does not match current cycle?
field.
On z/OS, these options are available in the ACR/Summary History
Items panel.
On Windows, UNIX, and Linux via the graphical interface
(ACR/Summary Client or ACR/Workbench for Summary), these
options are available on the History Item dialog via the Retrieve
most recent cycle and If item is not found fields.
The following example shows how this option works in a situation
where some jobs are unavailable. In this case, the Thursday and
Friday jobs are not available.

Notice the situation for the Do not use most recent cycle option.
The Friday values are not available, but the ACR/Summary job must
still use it. In this situation, the ACR/Summary job will use zeroes as
the values for that cycle.
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What Is Variable Cycle Processing?
Variable cycle processing allows you to control the retrieval of a
history item based on the run date and time or the cycle ID of another
job or both. This is unlike relative cycle processing, which relies
exclusively upon cycle IDs.
The purpose of variable cycle processing is to accommodate situations
where the run date and time of other jobs that provide the history
items are different than usual.
For example, you might have a weekly job that performs balancing
that uses the history items from daily jobs:

In this situation, the cycle processing indicates five relative cycles to
use for the weekly job.
However, the daily job might not run every day. For example, during
Thanksgiving week in the U.S., the daily processing for Thursday and
Friday might not take place.
If your ACR/Summary controls are for the financial industry, any
holiday might mean a cycle with no processing, and therefore no
historical data to use in a subsequent balancing job.
In our example, if the “five relative cycles” were used for input to the
weekly job, the job would use input data from Thursday and Friday of
the prior week.
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By using variable cycle processing, you could specify that only the
daily job cycles that have run since the last time the weekly job ran
will be picked up by the weekly job and used in balancing.
Variable cycle processing relies upon the cycle IDs or run dates of
retrieved history items. By making comparisons, ACR/Summary can
correctly choose to use or not use the history item.
ACR/Summary offers selections that match your processing
environment. These options are available in the Variable Cycle
panel, as shown below. Each option is discussed in detail in “Choosing
a Variable Cycle Processing Option” on page 9.

Specifying the Relative Cycle and Variable Cycle
On z/OS, the retrieved history item that you will use in your
comparisons is specified in the Relative cycle field in the History
Items panel (this corresponds to the History Item dialog box on
Windows, UNIX, and Linux).
On z/OS, the variable cycle ID that will be used for the Variable Cycle
job is specified in the Relative cycle field in the Variable Cycle panel
(this corresponds to the Variable Cycle dialog box on Windows, UNIX,
and Linux).
The following graphic shows:

 The History Items panel for the weekly sales job. This history item
accumulates the daily totals at week end.
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 The Variable Cycle panel for the weekly sales job. On z/OS, to access
this panel, choose Set advanced features > Variable cycle from
the History Items panel. On Windows, UNIX, or Linux, to access the
Variable Cycle dialog box, click on Variable Cycle in the History
Item dialog box.
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Choosing a Variable Cycle Processing Option
When setting up variable cycle processing, you will need to make
choices that reflect your processing environment. You have four
choices:






No variable cycle processing (option 1, the default)
Compared to cycle ID and most recent run date and time (option 2)
Compared to most recent run date and time (option 3)
Compared to most recent cycle number (option 4)

By carefully choosing the appropriate option for your site, you can be
sure that the history item that ACR/Summary uses for balancing is
the correct one.

Options 2, 3, and 4 are described in detail in this section.
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Compared to Cycle ID and Most Recent Run Date/Time
This option uses both the cycle ID and the run date and time to select
the history item.
This option will use a retrieved history item for balancing if either of
the following is true:
a. The retrieved history item cycle ID is greater than the variable

cycle history job’s cycle ID. (See “Example A” on page 10.)
b. The cycle IDs are equal and the run date and time of the

retrieved history item is greater than the run date and time of
the variable cycle history job’s cycle ID. (See “Example B” on
page 12.)

When to Use this Option
Use this option when your balancing jobs use the same cycle ID
format and it is possible that the retrieved history item cycle ID could
be the same as the current job cycle ID.

Example A
The following example shows which history is retrieved when the
history is normally retrieved from the day before, but it’s not
available. ACR/Summary selects the first available history item with
an earlier cycle ID. This option accommodates holidays or any other
situation where data must be retrieved from the last available
history.
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Example B
The following example shows how this option can locate history when
the cycle IDs are the same.

Compared to Most Recent Run Date and Time
This option relies on the run date and time only for selecting a history
item. This option will use a retrieved history item for balancing if its
run date and time are greater than the run date and time of the
variable cycle job ID.

When to Use this Option
Use this option if your two jobs did not store history in the same cycle
number format. For example, if one format is Gregorian and the other
format is Julian.
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Processing Logic Is Different for this Option
Note that when you choose this option, the processing logic is
different:

 When filtering in history records for external item and variable
cycle, histories will not be filtered based on cycle number.

 The Variable Cycle Most Recent Indicator will not be used.
 The Equal Cycle Comparison has no effect since Compared to most
recent run date and time will not exclude histories based on cycle
number.

Example
This example shows how ACR/Summary retrieves history based on
run date and time alone.
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Compared to Most Recent Cycle Number
This option uses cycle numbers only, no run numbers. This means it
will never retrieve histories that were run on the same cycle number.
This option will use a retrieved history item for balancing if its cycle
number is greater than the cycle number of the variable cycle history
job.

When to Use this Option
Use this option if you always want to retrieve history items from prior
cycles. This option is intended for those situations where both of the
following are true:

 You use the date for the cycle number.
 If the source job runs on the same day, you do not want the history
item.

Example
This example shows how ACR/Summary retrieves history based on
cycle number alone and ignores the run number.
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When the Variable Cycle ID Is Not Found
For those situations when the variable cycle ID is not found, you can
set the Most Recent Indicator.
This option lets ACR/Summary automatically choose which values to
use based on one of the following:

 Use the most recent cycle as +000. For example, if yesterday’s run is
the most recent cycle, then yesterday’s cycle becomes +000.

 No adjustment; only an exact match is considered +000. In this case,
the value you use for the Most recent indicator applies.
The graphic below shows how both options work when the relative
cycle is set to +000.

The graphic below shows how both options work when the relative
cycle is set to -001.

7/9/12

ACR/Summary Variable Cycle Processing Guide

15

1  Introduction
Choosing a Variable Cycle Processing Option

16

ACR/Summary Variable Cycle Processing Guide

7/9/12

2
Tutorial for z/OS
This tutorial will help you set up a complete working example of
variable cycle processing on z/OS. It uses data that is available on
your product media. Once set up, you can use this example to
experiment with different options and see the results.

What You Need To Know Before Starting
Before starting the tutorial, you need the following:

 You must have access to ACR/Summary.
 You must have performed the initial setup for your job cards and
initialized the definition database. If you have not done this, see the
ACR/Summary User Guide for z/OS.

 You must know how to run a balancing job online. If you do not, see
the ACR/Summary User Guide for z/OS.

 You must have access to the input files shipped on the product
media. The names of these files are the following:






UNI.TRNGRPT(MONSALES)
UNI.TRNGRPT(TUESALES)
UNI.TRNGRPT(WEDSALES)
UNI.TRNGRPT(SALESTOT)

These files will be using the high-level and middle-level qualifiers
assigned during installation of ACR/Summary. When you use the
instructions, you will need to prefix your qualifiers.
Verify you can find these files before you start the instructions.

What You Will Learn To Do
You will learn to create a variable cycle processing job by completing
the following tasks:






7/9/12

“Set Up the Daily Job” on page 18
“Set Up the Weekly Job” on page 25
“Set Up the History Item” on page 32
“Write the Rules” on page 34

ACR/Summary Variable Cycle Processing Guide

17

2  Tutorial for z/OS
Set Up the Daily Job

 “Prime the Database for the First Weekly Run” on page 36
 “Run the Weekly Job” on page 36
The graphic below shows the tasks you will be performing in the
example application.

Set Up the Daily Job
In these steps, you will create a basic ACR/Summary job with input
sources that provide the values for the internal item I-001.
1. Access an ACR/Summary job window.
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2. Select Job Information to open the Job Information panel.
Job Information
Enter a job ID:
Job name:
Step name:
Qualifier:
Enter control report title:
Select options to access:
Job run options...
Cycle processing options...
Alternate job ID information...
Rerun/audit trail options...
Extract file options...
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Note that if you wanted to specify batch cycle processing options,
you would select it from this panel. For this example, you will be
specifying online cycle options in a later step.
3. Enter the following information:

Job name: DAYSALES
Step Name: SALES
Control report title: DAILY SALES REPORT
4. Select Job run options to open the Job Run Options panel.
Job Run Options
Select a run option to modify:
1. Store history...
2. Set return code...
3. Perform file control...
4. Access user exit...
5. Truncate/round results...
6. Model definitions...
F1=Help

5.

F3=Exit

Enter 1. Store history to open the Store History panel.
Store History
Store balancing values in history? Y

(Y/N/I)

If yes, enter the number of runs to keep:

F1=Help

7/9/12
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(1-999)

F9=Swap

ACR/Summary Variable Cycle Processing Guide

19

2  Tutorial for z/OS
Set Up the Daily Job
6. Enter 005 as the number of histories to keep and press F5. Then

press F3 to return to the ACR/Summary Job window. The five
histories corresponds to the Monday through Friday accumulation.
7. Select <New> under B. Input Sources to open the Input Sources

panel, where you will specify the source of the daily jobs.
8. Complete the Input Sources panel.
a. Enter the following source data:

File description: SALES DAILY
DDNAME: SALES
DSName: XXXX.XXXX.TRNGRPT(MONSALES), where
XXXX.XXXX is your high-level and middle-level qualifier of
where your site unloaded the samples datasets.
b. Select a file organization of 1. Physical sequential.

Your input source should look like the following, using your highlevel and middle-level qualifiers, before you continue.
Input Sources
File number: 001
File description: SALES DAILY
File DDNAME: SALES
Qualifier: XX
DSName: XXXX.XXXX.TRNGRPT(MONSALES)
Display the above DSName in the extract window? Y (Y/N)
If yes, specify the range of lines to display: 00001 to

00100

File organization:
1
1. Physical sequential...
2. VSAM key sequenced (KSDS)...
3. Direct spool...
4. DB2...
Is this file a model? N
Use model definitions? N
File DDNAME:
Qualifier:
F1=Help
F2=Split

(Y/N)
(Y/N)

F3=Exit

F5=Accept

F9=Swap

9. Press F5 to open the Physical Sequential File Information panel.
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10. Enter 6. Select records satisfying selection on one line.

Access mode 6 allows you to process all records in the application
file for selection group processing. It does not create a file access
area. Access mode 6 tallies or accumulates records that need
multiple selection criteria with one input record. You can use this
access mode to pick up detail fields that follow or are on the same
record as your selection fields.
11. Press F5 to return to the ACR/Summary Job Window and then

select Window > 1. Extract to open the File ID panel.
Row 3 from 3
File ID List
SALES
XXXX.XXXX(MONSALES)
********************* Bottom of data **********************

Command ===>
F1=Help
F3=Exit

F7=Up

F8=Down

12. Choose SALES from the File ID panel. Your Extract Window should

contain the following data before you continue.
Extract Window
File name: SALES
LINES 00000011 COL 0001 0072
----+----1----+----2----+----3----+----4----+----5----+----6----+----711/25/02
DAILY SALES REPORT
OFFICE
IL
NY
TX
NY
IL
NY
TX
NY

EMPLOYEE
SMITH,D
JONES,R
BACKER,C
BERT,KR
ABAM,E
DECKER,W
BLITT,B
CANNES,L

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

DEPARTMENT
6
6
5
7
1
2
6
8

F3=Exit
F9=Swap

SALES
$347.00
$982.00
$1,004.00
$341.00
$828.00
$136.00
$798.00
$2,167.00

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

In this panel, you will be identifying the selection field.
A selection field identifies the line or record that contains the
values to be extracted. For example, if you want the system to look
for values in all the records that have a numeric character in the
first position, you would indicate this in the selection field
definition type. Each time the system finds a numeric character in
the first position of a record, the system scans the entire record for
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other file definitions. If there is not a numeric character in the first
position, the system skips the record and goes on to the next.
In this panel, you are going to identify the field TX as the selection
field, meaning only those records with TX will be selected for
accumulation.
13. Place the cursor on the first character of TX and press F6. This will

open a panel in which you can select a definition type.
14. Enter 1. Selection field to open the Selection Field panel.

Notice that the Field position contains 0005, which is the location of
the first character of TX. The line reference at the top shows the
source record.
Selection Field

Line reference
Input type:
1
Field position:
Field format: 2
Field type:

3

----+----1----+----2----+----3----+----4
TX
BACKER,C
5
$1,004.00
1. Input Area
2. Extraction Variable
0005_ Field length:
_2
1. Numeric
2. Alphanumeric 3. Packed decimal
4. Zoned decimal 5. Binary
6. Unsigned packed
1. Count
2. Amount
3. Text

----------------- Selection Criteria -----------------If blank is one of the comparison values, it must be entered here.
Value 1: TX______________ Value 2: ________________ Additional? N (Y/N)
Selection type: _1 1. Equal to
2. Not =
3. Numeric 4. Alphabetic
5. Greater than 6. Less than 7. Blank
8. Nonblank
9. Within range 10.Begin =
11.End =
12.Locate =
13.Outside range14.Greater = 15.Less = 16.Advance
Extraction variable number: ___ (1-999)
Additional field?
1 1. Any record 2. Same record 3. Not same record
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

15. Enter the following data and then press F5 to return to the Extract

Window.
Field length: 2
Field format: 2
Field type: 3 (text)
Value 1: TX
Selection type: 1 (Equal to)
This combination says “select the record if the characters in
positions 0005 and 0006 are equal to TX.”
Now the detail field needs to be defined to tell ACR/Summary what
data to extract once it has found the record identified by TX.
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16. Place the cursor on the 1 in the $1,004.00 amount and press F6 to

again open the panel to select a definition type, as shown in step 13
on page 22.
17. Enter 3. Detail field to open the Detail Field panel.
Detail Field
Select an input source:
1_ 1. Input record...
2. Extraction variable...
Specify a destination:
1_ 1. Internal item...
2. Extraction variable...
Is this an extended internal item?
F1=Help
F3=Exit

N

(Y/N)

A detail field contains the values to be extracted and used in rules
when balancing is run. Values stored in detail fields can be
accumulated if all criteria is met. You can set the system up to add
each of the values for that detail field and provide a total.
In this example, the detail field contains the sales amount, which
we want accumulated.
18. Press Enter to accept the defaults and open the Detail Field Source

(Input Record) panel.
Detail Field Source (Input Record)
Line reference

----+----1----+----2----+----3----+----4
1,004.00

Field position: 0047

Field length: 8

Field format
1
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

Negative sign indicator to be used instead of default:
Is this field a date field? N (Y/N)
Will this field be translated using a translation table?
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap
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ACR/Summary Variable Cycle Processing Guide

N

(Y/N)

23

2  Tutorial for z/OS
Set Up the Daily Job
19. Enter a field length of 8 and press F5 to open the Detail Field

Destination (Internal Item) panel.
Detail Field Destination (Internal Item)
Assign the extracted detail value
to internal item number: I 001 (1-100)
Set a processing option for the extracted values:
1_ 1. Accumulate the extracted detail values
2. Tally the extracted detail values
3. Extract the last value
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Detail fields are stored in internal items. In this panel you specify
the internal item to use for accumulation and the accumulation
option. In a later step, you will perform the setup for the internal
item. If you wanted to simply count the number of records that
match the selection field criteria, you would select the Tally option.
20. Accept the default of I-001 for the internal item and 1. Accumulate

the extracted detail values and press F5 to open the Internal Items
panel.
Internal Items
Internal
Item number
001

-------------- Description ------------TEXAS SALES_____________________________
________________________________________

Print format:
2
1. Count
2. Amount
3. Date
4. Text

Print the internal item value:
1
1. In the left column of the control report
2. In the right column of the control report
3. Item is a calculated item result; print on
left

Print decimals: 0
Specify
1
1.
2.
3.

000

(1-100)

an action to take when an internal item is not found:
Set internal item to zero or spaces and continue processing
The internal item is required for an in-balance condition
Skip all balancing rules involving the internal item

Print commas?
F1=Help
F8=Next

24

Calculated item number:

1

1. Default

F2=Split
F9=Swap

2. Print

F3=Exit

3. Do not print

F4=Retain

F5=Accept
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21. Enter the following information and then press F5 to return to the

Extract Window.
Description: TEXAS SALES
Print format: 2. Amount
Print decimals: 0
You will use the defaults for the remaining options.
22. Select View > Definitions. This will display the definitions you just

created. Compare them to the one shown below and correct any
errors before continuing.
Extract Window

Row 1 to 2 of 2

File name: SALES
SELECT IF POS 0005 FOR 02 = TX
TOTAL THE VALUES AT 0047 FOR 08, STORE IN I-001
***************************** Bottom of data ***************************

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

23. Save your job before continuing.

Set Up the Weekly Job
This job extracts the weekly values and stores it in an internal item.
1. Create a new job for the weekly sales. Enter the following

information:
Job name: SALESTOT
Step Name: SALES
Control report title: WEEKLY SALES REPORT
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Verify your job looks like the following and then press F5.
Job Information
Job name: SALESTOT
Step name: SALES
Qualifier:
Enter control report title:
WEEKLY SALES REPORT
Select options to access:
Job run options...
Cycle processing options...
Alternate job ID information...
Rerun/audit trail options...
Extract file options...
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

2. Select Job run options and press F5 to open the Job Run Options

panel.
3. Enter 1. Store History to display the Store History panel.
Store History
Store balancing values in history? Y

(Y/N/I)

If yes, enter the number of runs to keep:

F1=Help

F2=Split

F3=Exit

002

F5=Accept

(1-999)

F9=Swap

4. Enter 002 as the number of runs to keep and press PF5 to return to

the ACR/Summary Job Window.
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5. Set up your input source as you learned to do in step 7 on page 20.

Use the information shown below:
Input Sources
File number: 001
File description: WEEKLY SALES
File DDNAME: WEEKLYSL Qualifier:
DSName: XXXX.XXXX.XXXXX(SALESTOT)
Display the above DSName in the extract window? Y (Y/N)
If yes, specify the range of lines to display: 00001 to

00100

File organization:
1
1. Physical sequential...
2. VSAM key sequenced (KSDS)...
3. Direct spool...
4. DB2...
Is this file a model? N
Use model definitions? N
File DDNAME:
Qualifier:
F1=Help
F2=Split

(Y/N)
(Y/N)

F3=Exit

F5=Accept

F9=Swap

6. Verify your Job Information window looks like the graphic above

and press PF5 to open the Physical Sequential File Information
panel.
Access Mode 1 selects the first X records from the input source and
places them in the file access area (temporary storage). You will
specify the X in the Maximum number of records to process field
in an upcoming step. This access mode is appropriate for input
sources where the values to be extracted reside at the top of the file.
7. Enter 1. Select first x records and press PF5 to accept and open the

Record Information panel.
8. Enter 100 records to process and press PF5 to return to the

ACR/Summary Job Window.
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9. Select Window > 1. Extract Window and then select the

WEEKLYSL report.
Extract Window
File name: WEEKLYSL
LINES 00000008 COL 0001 0072
----+----1----+----2----+----3----+----4----+----5----+----6----+----711/21/02
WEEKLY SALES TOTALS
OFFICE
IL
NY
TX
TOTAL

SALES
$25,529
$15,484
$ 8,621
------$49,634

Command Line ===>
F1=Help
F2=Split
F7=Up
F8=Down

F3=Exit
F9=Swap

Scroll ===> PAGE
F4=Actions F5=Repeat
F6=Add
F10=Left
F11=Right

10. Place the cursor on the T of TX and press F6 to open the Select a

definition type panel.
Select a definition type:
1.
2.
3.
4.
5.
F1=Help

Reference record...
Relative record...
Page/line record...
Embedded key...
Field value...
F3=Exit

If you do not see all five selections in the panel, then you did not
specify an access mode of 1. Return to step 6 on page 27 and change
the access mode before continuing.
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11. Enter 4. Embedded Key to open the Embedded Key Record panel.

An embedded key finds a record by searching for a text string. The
text string in this case is TX.
Embedded Key Record
Key value:
Chars. 1-40
Chars. 41-80

----+----1----+----2----+----3----+----4
TX
$ 8,621
________________________________________

Start position: 00000 Length: __ Key occurrence: 001
If start position can vary, specify maximum start position: ____
If the key value is missing, bypass this balancing step? N

(Y/N)

Use the value of this extraction variable as the embedded key: ___
Extended? N (Y/N)
F1=Help
F2=Split
F3=Exit
F5=Accept F6=ExtVar F9=Swap

12. Enter a length of 2 and press F5 to return to the Extract Window.
13. Place your cursor on the blank space between the $ and the 8,621

and press F6 to open the Select a definition type panel again.
This is the same panel you saw in step 10 on page 28.
14. Enter 5. Field Value to open the Field Value panel. In this panel you

tell ACR/Summary what to extract after finding the value specified
with the embedded key.
Field Value
Line reference:

----+----1----+----2----+----3----+----4
8,621.00

Field position: 00015 Field length:_9
Can this field value position vary? N (Y/N)

1

Input field format:
1. Numeric
2. Alphanumeric
3. Packed decimal
4. Zoned decimal
5. Binary
6. Unsigned packed

Will this be stored as a date in an internal item? N (Y/N)
Will this be stored as a cycle number? N (Y/N)
Is the destination an extended item? N (Y/N)
Will this field be translated using a translation table? N
F1=Help
F2=Split
F3=Exit
F5=Accept
F9=Swap
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15. Enter a field length of 9 and press F5 to open the Output Value

panel. In this panel, you tell ACR/Summary what format to use for
storing the value.
Output Value
Specify
2
1.
2.
3.
4.
5.
6.

output format:
Count
Amount
Text
Cumulative count/amount
Job-step qualifier
Control field for alternate balancing rules

Assign to internal item number: 001
or
extraction variable number:
Override sign processing?
F1=Help

F2=Split

N

(Y/N)

F3=Exit

F5=Accept

F9=Swap

16. Enter 2. Amount as the output format and press F5 to open the

Internal Items panel.
Internal Items
Internal
Item number
001

-------------- Description -------------

Print format:
2
1. Count
2. Amount
3. Date
4. Text
Print decimals:_0
Specify
1
1.
2.
3.

Print the internal item value:
1
1. In the left column of the control report
2. In the right column of the control report
3. Item is a calculated item result; print on
left
Calculated item number: 000 (1-100)

an action to take when an internal item is not found:
Set internal item to zero or spaces and continue processing
The internal item is required for an in-balance condition
Skip all balancing rules involving the internal item

Print commas?
F1=Help

1

1. Default

F2=Split

2. Print

F3=Exit

3. Do not print

F5=Accept

F6=Cancel

F9=Swap

17. Enter a 0 in the Print decimals field. This entry is necessary

because the input source does not use decimal places.
18. Enter a description of SALES WEEKLY TOTAL, press F5 to return

to the Extract Window.
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19. Select View > Definitions to display the definition you just created.

Verify your definition looks like the following:
Extract Window

Row 1 to 2 of 2

File name: WEEKLYSL
OCC 001 OF EMBEDDED KEY=TX
PICK UP VALUE AT 0015 FOR 09, STORE IN I-001
***************************** Bottom of data ***************************

Command Line ===>
F1=Help
F2=Split
F9=Swap

F3=Exit

F4=Actions

F7=Up

F8=Down

Correct any errors before continuing.
20. Press F3 to return to the ACR/Summary Job Window.
21. Save your job before continuing.
22. Select Run > 1. Balancing to open the Balancing Run Options

panel.
Balancing Run Options
Set overrides for one or more of the following:
Cycle number: . . 20060304
Run number: . . .
Rule set override:
Store history override:
(Y/N/I)
F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

The purpose of running a balancing job now is to prime the history
database.
23. Run the weekly job one time using the SALESTOT input source.

Use these options:
Cycle number: 20060304
Run number: [Blank]
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Set Up the History Item
The weekly history item (E-001) is where you specify the cycle
accumulation, the relative cycle processing, and the variable cycle
processing.
The ACR/Summary Job Window must be showing before you continue.
1. Select <New...> under D. History Items to open the History Items

panel. You will use this panel to specify that history will come from
the DAY SALES job.
History Items
Item number
001

-------------- Description ------------DAILY SALES TOTAL_______________________
________________________________________

History job ID:
Job name: DAYSALES
Step name: SALES___
Qualifier: __

Internal item number: I

001

Relative cycle: -004

(1-100)
(-998 to +000)

Should most recent cycle be retrieved when cycle does not match
current cycle? N (Y/N)
Specify
2_ 1.
2.
3.

an action to take when a history is not found:
Set the history item to zero or spaces and continue processing
Set all rules involving this item out of balance
Skip all balancing rules involving the history item

Set advanced features? Y (Y/N) Cross platform history item? N (Y/N)
F1=Help
F2=Split
F3=Exit
F5=Accept
F7=Prev
F8=Next
F9=Swap

2. Complete the History Items panel.
a. Enter the following information:

Description: DAILY SALES TOTAL
Internal item number: 001
Job name: DAYSALES
Step name: SALES
Relative cycle: -004
Use the defaults for the remaining fields.
Note that the relative cycle of -004 provides for each day of the
week. For a detailed explanation, see “What Is Relative Cycle
Processing?” on page 4.
b. Enter Y in the Set advanced features? field. This is how you

access the variable cycle processing features.
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c. Press F5 to open the Advanced History Features panel.
Advanced History Features
Select features to access:
Variable cycle...
Cycle accumulation...
Equal cycle comparison...
F1=Help

F2=Split

F3=Exit

F9=Swap

This panel is displayed because you entered a Y for the Set
advanced features field in the previous panel.
3. Select both Variable Cycle... and Cycle accumulation... and press

Enter to open the Variable Cycle panel.
Variable Cycle
Variable cycle indicator:
2
1. Variable cycle processing not in effect
2. Compared to cycle ID and most recent run date and time
3. Compared to most recent run date and time
4. Compared to most recent cycle number
Variable cycle information:
Job name: SALESTOT
Step name: SALES
Qualifier:
Relative cycle: -001

(-998 to +000)

Most recent indicator:
2
1. Use most recent
2. Exact match only
Is this a variable cycle cross platform(XP) history item? N
F1=Help

F2=Split

F3=Exit

F5=Accept

(Y/N)

F9=Swap

The fields for Variable Cycle Information determine the base for
your variable cycle.
See “Choosing a Variable Cycle Processing Option” on page 9 for a
detailed explanation of the variable cycle indicator options.
4. Complete the Variable Cycle panel:
a. Enter the following information:

Variable cycle indicator: 2. Compared to cycle ID and most
recent run date and time
Job name: SALESTOT
Step name: SALES
Relative cycle: -001
Most recent indicator: Exact Match Only for the Most recent
indicator.
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b. Press F5 to open the Cycle Accumulation panel.
Cycle Accumulation
Relative
cycle: . . . -004
Specify
2
1.
2.
3.

(-998 to +000)

a cycle accumulation option:
Retrieve from the relative cycle thru the -001
Retrieve from the relative cycle thru the +000
Do not perform cycle accumulation

F1=Help

F2=Split

F3=Exit

F5=Accept

F9=Swap

Cycle accumulation allows you to quickly accumulate values from
multiple runs into one history item. For this tutorial, we will have
cycle accumulation add all the values it finds from the last five
cycles. This includes the -004 relative cycles and the +000 cycle.
See “What Is Relative Cycle Processing?” on page 4 for more
information.
5. Enter a 2. Retrieve from the relative cycle thru the +000 and press

F5 to return to the ACR/Summary Job Window.

Write the Rules
In these steps, you will write a rule to compare the value accumulated
from the SALES input source (I-001) and the value extracted from the
weekly report (E-001).
1. Select <New...> under F. Rules to open the Balancing Rules panel.
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2. Enter 1. Standard rule to open the Standard Rules panel.
Standard Rules
Rule number: 001 Alternate Balancing Rule?: N
-------------------------------Formula----------------------------LHS: I-001
Balancing operator: = EQ (EQ, NE, GT, LT, GE, LE)
RHS: E-001
Description:
Return code: 3000 Is rule active? Y
Calculated item to process: ___
Rule action:
1
1. Default
2. Set completion code
3. Set abend code
Print commas?
F1=Help
F7=Prev

1

1. Default

F2=Split
F8=Next

(Y/N)

Set tolerance? N
Print decimals: _

(Y/N)

Print format:
1
1. Count
Print decimals:
2. Amount
3. Date
4. Text
2. Print
3. Do not print

F3=Exit
F9=Swap

F4=Retain

F5=Accept

F6=Items

3. Complete the Standard Rules panel:
a. Enter the following data:

LHS: I-001
Balancing operator: EQ
RHS: E-001.
Return code: 3000.
You can use the defaults for the remaining fields.
b. Press F5 to open the Direct Messages panel.
Direct Messages
Message number: 001
Return
Message text
code
---------------------------------------3000
DAILY TOTALS DO NOT EQUAL WEEKLY TOTAL
Write message to:
1
1. Control report
2. Console and control report (no response
required)
3. Console and control report (response
F1=Help
F2=Split
F3=Exit
F4=Retain F5=Accept
F7=Prev
F8=Next
F9=Swap

4. Enter a message text of DAILY TOTALS DO NOT EQUAL WEEKLY

TOTAL and press F5 to return to the ACR/Summary Job Window
5. Check your job window and then save the job.
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Prime the Database for the First Weekly Run
The very first time you try to run a variable cycle processing job, you
will receive error messages. That’s because there’s no history to use
in the balancing. By priming the database, you prepare to run
production balancing for the first time.
Run the DAYSALES job three times for Monday, Tuesday, and
Wednesday, using the following input sources: MONSALES,
TUESALES, WEDSALES.
Increase the cycle number each time:
MONSALES: 20060304
TUESALES: 20060305
WEDSALES: 20060306
You do not need to use a run number.

Run the Weekly Job
Now that you have historical data available to use in the rules, you
are ready to run your first variable cycle processing job.
1. Run the weekly job SALESTOT again. This will now contain the

three days worth of information that were extracted with the
DAYSALES job.
Use a higher cycle number (20060307) than you used for the
SALESTOT primer run.
2. Review your control report. Note the **VARIABLE CYCLE** in the

History Items section.
If you have an out-of-balance condition, make you have done the
following:

 Incremented the cycle numbers correctly
 Changed the input files for each of the daily jobs as described in
“Prime the Database for the First Weekly Run” on page 36.
For more information, see “Troubleshooting and FAQs” on page 59.
After you have a working variable cycle processing job, you can
experiment with the various options.
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This tutorial will help you set up a complete working example of
variable cycle processing on Windows. It uses data that is available
on your product media. Once setup, you can use this example to
experiment with different options and see the results.

What You Need To Know Before Starting
Before starting the tutorial, you need the following:

 You must have access to ACR/Workbench for Summary or
ACR/Summary Client.

 You must have initialized the definition database. If you have not
yet done this, see the ACR/Summary User Guide for Windows,
UNIX, and Linux.

 You must know how to run a balancing job online. If you do not, see
the please use your ACR/Summary User Guide for Windows, UNIX,
and Linux.

 You must have access to the input files shipped on the product
media. The names of these files are the following:






monsales.rpt
tuesales.rpt
wedsales.rpt
salestot.rpt

The default location for these files is the following:
c:\Infogix\Summary32\sample
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What You Will Learn To Do
You will learn to create a variable cycle processing job by completing
the following tasks:








“Set Up the Daily Job” on page 39
“Set Up the Weekly Job” on page 46
“Set Up the History Item” on page 51
“Write the Rules” on page 54
“Prime the Database for the First Weekly Run” on page 56
“Run the Weekly Job” on page 57

The graphic below shows the tasks you will be performing in the
example application.
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Set Up the Daily Job
In these steps, you will create a basic ACR/Summary job with input
sources that provide the values for the internal item I-001.
1. Double-click Name under Basic Information and complete the

Control Task (Job) Name dialog box with the following information:
Job Name: DAYSALES
Step Name: SALES
Report Title: DAILY SALES REPORT
Use the defaults for the remaining options and click OK.

2. Double click Store History to open the Store History dialog box.

3. Use the default Always store history setting, enter 5 as the

number of histories to keep, and then click OK.
4. Double click <New...> under Input Sources to open the Input

Source view.
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5. Double click Name under Basic Information to open the Name

dialog box.

6. Enter a File ID of SALES and then click Browse next to File Name

to open the Select File dialog box.

In this dialog box, you will select the input source file for daily
sales.
7. Navigate to the Samples folder, select Monsales.rpt, and then click

Open to return to the Name dialog box.
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8. Click OK to return to the Input Source view. The lower pane now

shows the DAILY SALES REPORT for Monday.

9. Double click File Description to open the File Description dialog

box.
10. Enter SALES DAILY and click OK to return to the Input Source

view.
11. Double click File Organization to open the File Organization dialog

box.

12. Select 6 - Select records that match 1 line from the Access Mode

list and click OK.
Access mode 6 allows you to process all records in the application
file for selection group processing. It does not create a file access
area. Access mode 6 tallies or accumulates records that need
multiple selection criteria with one input record. You can use this
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access mode to pick up detail fields that follow or are on the same
record as your selection fields.
13. Highlight TX in the lower pane and then click the Selection button

in the toolbar to open the Selection Field dialog box.

Because you selected the key value from the report using the markand-capture method, the selection fields in this dialog box are
already complete.
We are also going to use the default comparison type of Equal to.
This dialog box now says “select the record if the characters in
positions 0005 and 0006 are equal to TX.”
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14. Click OK to return to the Input Source view, which now shows the

selection criteria under Record/Field definitions.

.

15. Highlight 1,004.00 in the lower pane and then click the Detail

button in the toolbar to open the Detail Field dialog box.

A detail field contains the values to be extracted and used in rules
when balancing is run. Values stored in detail fields can be
accumulated if all criteria is met. You can set the system up to add
each of the values for that detail field and provide a total.
In this example, the detail field contains the sales amount, which
we want accumulated.
Because you selected the key value from the report using the markand-capture method, the fields in this dialog box are already
complete.
Now you need to specify where to store the value the detail field
will pick up.
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16. Click Create to open the Internal Item dialog box.

17. Enter the following information:

Name: TEXAS SALES
Description: DAILY TEXAS SALES
Format: Amount
Decimals: 2
Print commas: Yes
Use the defaults for the remaining fields.
18. Click OK to return to the Detail Field dialog box and then click OK

again to return to the Input Source view.
The internal item storage information is now showing under the
selection criteria.
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19. Check your work against the above graphic and correct any errors

before continuing. Then select File > Save.

20. Enter VCP_Tutorial.tsk as the file name and click Save.
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Set Up the Weekly Job
This job extracts the weekly values and stores it in an internal item.
1. Select File > New to open the New dialog box.

2. Click OK to accept the default of Control Task (Job). A new Control

Task (Job) window is displayed.
3. Double click Name to open the Control Task (Job) Name dialog box.

4. Enter the following information:

Job Name: SALESTOT
Step Name: SALES
Report title: WEEKLY SALES REPORT
5. Click OK to return to the Control Task (Job) window.

46

ACR/Summary Variable Cycle Processing Guide

7/9/12

Tutorial for Windows  3
Set Up the Weekly Job
6. Double click Store History to open the Store History dialog box.

7. Enter 2 as the number of runs to keep and click OK to return to the

Control Task (Job) window.
8. Double click Input Sources to open the Input Source view.
9. Double click Name to open the Name dialog box.

10. Enter SALESTOT as the file ID.
11. Click Browse next to File Name and navigate to the Samples folder.
12. Select Salestot.rpt and click OK.

13. Click OK to return to the Input Source window. The Weekly Sales

Totals report is now showing in the lower pane.
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14. Double click File Organization to open the File Organization dialog

box.

Access Mode 1 selects the first X records from the input source and
places them in the file access area (temporary storage). This access
mode is appropriate for input sources where the values to be
extracted reside at the top of the file.
15. Verify that the Access Mode is 1- First X records and the Max

Record Count is 100, then click OK to return to the Input Source
window.
16. Double click <New...> under Record/Field Definitions to open the

Extraction Field Type dialog box.

17. Select Embedded Key and click OK to open the Embedded Key

dialog box.
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18. Enter a Key Value of TX and Length of 2 and click OK to return to

the Input Source window.
Your new extraction definition is now showing in the Record/Field
Definitions section.
19. Select 8,621 so that it is highlighted and the highlight includes the

space between the $ and the 8,521.
20. Click the Field Item icon to open the Field Item dialog box.

21. Enter a field length of 6, a Field Type of Amount, and then click

Create to open the Internal Item dialog box.

22. Enter the following information:

Name: DAILY WEEKLY TOTAL
Description: DAILY WEEKLY TOTAL
Format: Amount
Decimals: 0
23. Click OK to return to the Field Item dialog box and then click OK

again to return to the Input Source window.
24. Save your Control Task as VCP_Tutorial2.tsk.
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25. Select Run > Balancing to open the Balancing dialog box.

26. Run the weekly job one time using the SALESTOT input source

and a cycle number of 20060304.
27. Select View > Open all reports. You will find a report with the

following message:

28. This message indicates that no history is available to use for

balancing. This is OK and now your history data is primed for later
runs.
29. Close the message and view your Control Report.
30. Select File > Close to return to the Input Source window.
31. Select Window > Control Task (Job) SALESTOTSALES to return to

you control task.
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Set Up the History Item
The weekly history item (E-001) is where you specify the cycle
accumulation, the relative cycle processing, and the variable cycle
processing.
1. Double click <New...> under History Items to open the History Item

dialog box.

2. Enter the following information:

Name: DAILY SALES TOTAL
Description: DAILY SALES TOTAL
Internal Item Number: 001
Relative cycle: -004
Accumulation option: Retrieve from the relative cycle through
+000
3. Click Job List to open the Control Tasks dialog box.

4. Select DAYSALES/SALES and click OK to return to the History

Item dialog box.
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5. Click Variable Cycle to open the Variable Cycle dialog box.

6. Select Compared to cycle ID and most recent run date and time.
7. Click Job List to open the Control Tasks dialog box.

8. Select SALESTOTSALES and click OK to return to the Variable

Cycle dialog box.
9. Enter a Relative Cycle of -1.
10. Verify your variable Cycle dialog box looks like the following and

then click OK:
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11. Verify your History Item dialog box looks like the following.

Click OK to return to the Control Task (Job) window.
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Write the Rules
In these steps, you will write a rule to compare the value accumulated
from the SALES input source (I-001) and the value extracted from the
weekly report (E-001).
1. Double click <New...> under rules to open the Rule Type dialog box.
2. Click OK to select the default of Standard Rule and to open the

Standard Rule dialog box.

3. Enter the following data in the General Tab:

Name: COMPARE DAILY TOTALS TO WEEKLY TOTALS
Description: COMPARE DAILY TOTALS TO WEEKLY TOTALS
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4. Click the Comparison tab.

5. Be sure the Left-hand side radio button is selected, then click

DAILY SALES TOTAL in the Available Items list, then click <Add.
6. Click the Right-hand side radio button.
7. Select DAILY WEEKLY TOTAL in the Available Items list and click

<Add.
8. Click OK to return to the Control Task (Job) window.
9. Double click <New...> under Messages to open the Message Type

dialog box.
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10. Click OK to accept the Direct Message default and open the Direct

Message dialog box.

11. Enter a return code of 3000 and a message of DAILY TOTALS DO

NOT EQUAL WEEKLY TOTAL.
12. Click OK to return to the Control Task (Job) window.

Prime the Database for the First Weekly Run
The very first time you try to run a variable cycle processing job, you
will receive error messages. That’s because there’s no history to use
in the balancing. By priming the database, you prepare to run
production balancing for the first time.
1. Open your DAYSALES Control Task (Job).
2. Select Run > Balancing to open the Balancing dialog box.
3. Run the DAYSALES job three times—once for Monday, Tuesday,

and Wednesday, using the following input sources: Monsales.rpt,
Tuesales.rpt, Wedsales.rpt.
Increase the cycle number each time:
Monsales.rpt: 20060304
Tuesales.rpt: 20060305
Wedsales.rpt: 20060306
You do not need to use a run number. Verify you have a step
completion code of 000 after each run.
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Run the Weekly Job
Now that you have historical data available to use in the rules, you
are ready to run your first variable cycle processing job.
1. Run the weekly job SALESTOT again. This will now contain the

three days worth of information that were extracted with the
DAYSALES job.
Use cycle number 20060307 for this run.
2. Review your control report. If you have an out-of-balance condition,

make you have done the following:

 Incremented the cycle numbers correctly
 Changed the input files for each of the daily jobs as described in
step 3 on page 56.
For more information, see “Troubleshooting and FAQs” on page 59.
After you have a working variable cycle processing job, you can
experiment with the various options.
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Troubleshooting
These steps provide a guideline for you to troubleshoot your variable
cycle processing job.

Step 1. Check for Messages in the SYSOUT
If you find an error message, check the explanation in the message
and codes guide. Below are the error messages most commonly
associated with variable cycle processing.
#UAN125W

NO INFORMATION IN UNITECH DATABASE FOR
VARIABLE CYCLE REFERENCE JOB ID CYCLE
REFERENCE JOB/STEP/QUALIFIER: PROCESSING
WILL CONTINUE USING 00000000 AS THE VARIABLE
REFERENCE CYCLE NUMBER

You are missing the reference job ID in the definition database. By
substituting zero, processing will continue.
#UBS028W

NO ENTRY IN CYCLE TABLE FOR RELATIVE CYCLE
CYC#. JOB-ID
E-999 NOT FOUND

You have specified the use cycle table option, but the cycle number for
the history item that you specified could not be located in the cycle
table. Ensure that you specified the correct history item and check to
see if the cycle ID and the job ID are valid.
#UBS029W

NO HISTORY IN UNITECH DATABASE FOR VARIABLE
CYCLE REFERENCE JOB CYC-JOB-ID USED BY
CURRENT JOB-ID E-999

The variable cycle reference job ID for the history item was not found
in your history file. Therefore, the history item cannot be processed.
Check to see if the variable cycle job ID was changed or deleted and
then confirm your spelling of the variable cycle reference job ID.
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Step 2. Check Your Control Report
If your input jobs run OK, but the balancing job does not, check your
control report for the **VARIABLE CYCLE** message in the INPUT
column, as shown below.

If you are missing the message, then you have not set up your job for
variable cycle. If you are using z/OS, review the steps in “Set Up the
History Item” on page 32. If you are using Windows, review the steps
in “Set Up the History Item” on page 51.

Step 3. Check for Discrepancies Using the List Definition Utility
Discrepancies in jobs and file definitions can cause unpredictable
results. To troubleshoot, you can print the history database and the
definition database and review the contents.
The following lists some potential problems you can look for:
Job Definition Problems—Look for the following:






Incorrect format of an item
Incorrect extraction from history database
Calculation value is incorrect
Logic in rules is wrong

File Definition Problems—File definitions tell the system how to
extract data values from the input file for balancing/reconciliation.

 Incorrect reporting of an internal item
 Values are missing
 Truncation of an internal item
Running the List Definition Utility on z/OS
1. Select Setup > 4. Database Utilities to open the Database

Utilities panel.
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2. Select 1. Database report utilities to open the Database Report

Utilities panel.
3. Select 1. List definitions to open the Library Information

panel.
4. Enter your dataset name and member name and press F5 to open

the List Definitions panel.
5. Verify that the job name and definition database name are the ones

you want and then select 2. Files to open the File Definitions
panel.
6. Enter the file DDName and qualifier. Leave blank to list all

definitions. When you press F5, the JCL to list your definitions
displays.
7. Submit the JCL and review the output.

Running the List Definition Utility on Windows
Select Run > Database Utilities > List Definitions to open the
List Definitions panel. Select the list type to run from the dropdown list.

Step 5: Browse History for an Extraction Problem
History browse lets you look at the contents of your history database. It
allows you to view the following:








Job ID
Status of the job
Highest return code set by balancing
Cycle number, run number, run date and start time
Internal item numbers, descriptions and values
Rerun information.

Note:

When history browse is executed, the definition database cannot be
read or updated by any other job.

To browse history on z/OS, perform these steps:
1. Select Run > 2. On-Line options to open the On-Line Options

panel.
2. Select 4. Perform history browse to open the History Browse

panel.
3. Enter your history database fully qualified name to open the Job ID

selection list.
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If you want to filter the results, enter a Y to the Set search
criteria for data viewing? This will display an additional panel
for filtering.
4. Select your job from the list and press Enter.

Frequently Asked Questions
This sections answers the questions Infogix hears most often about
variable cycle processing.
What is the difference between a cycle number and a run number?
A run number helps ACR/Summary distinguish between two jobs
that have the same cycle number. If you are running two jobs on the
same day and using the date as the cycle number, their cycle number
will be the same. Use the run number to separate them.
Do I have to use both a cycle number and a run number?
If you do not need to distinguish between cycle numbers for any
reason, use the default run number of 000.
Why do I get error messages the first time I run my variable cycle
processing job?
You need to prime the database so there is data to use. If you are on
z/OS, see “Prime the Database for the First Weekly Run” on page 36.
If you are on Windows, see “Prime the Database for the First Weekly
Run” on page 56.
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